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Legal Information

©1994–2003 Roxio, Inc. All rights reserved. No part of this publication may be reproduced, 
stored in a retrieval system, or transmitted in any form or by any means, electronic, 
mechanical, photocopying, recording or otherwise, without the prior written consent of 
Roxio, Inc., 455 El Camino Real, Santa Clara, CA 95050.

Roxio, the Roxio logo, the burning CD logo, Easy CD & DVD Creator, The Digital Media 
Suite, Disc Copier, DVD Builder, Label Creator, AudioCentral, Creator Classic, Roxio 
Player, Roxio Updater, and Drag-to-Disc are trademarks of Roxio, Inc., which may be 
registered in some jurisdictions.

Easy CD Creator, PhotoSuite, and Web-CheckUp are registered trademarks of Roxio, Inc. 
in the U.S., and may be registered in some other jurisdictions.

Microsoft, Windows, Windows Media, the Windows Media logo, Windows 98, Windows 
2000, Windows Me, and Windows XP are trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries.

QDesign MP3 Audio Codec. Copyright 1999-2000. QDesign Corporation. All rights 
reserved. For more information, visit http://www.qdesign.com.

MPEG Layer-3 audio compression technology licensed by Fraunhofer IIS and Thomson 
multimedia. http://www.iis.fhg.de/amm/.
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mp3PRO audio coding technology licensed from Coding Technologies, Fraunhofer IIS and 
Thomson multimedia.

For DVD Builder software - Primary interface design by XEODesign®, Inc. http://
www.xeodesign.com.

Music recognition technology and related data are provided by Gracenote and the 

Gracenote CDDB® Music Recognition Service (sm). Gracenote is the industry standard in 
music recognition technology and related content delivery. For more information visit 
www.gracenote.com.

Gracenote is CDDB, Inc. d/b/a “Gracenote.” CD and music-related data from Gracenote 

CDDB® Music Recognition Service (sm) © 2000, 2001 Gracenote. Gracenote CDDB2 Client 
Software © 2000, 2001 Gracenote. U.S. Patents Numbers #5,987,525; #6,061,680; 
#6,154,773, and other patents issued or pending.

CDDB is a registered trademark of Gracenote. The Gracenote logo and logotype, the 
Gracenote CDDB logo and logotype, and the “Powered by Gracenote CDDB” logo are 
trademarks of Gracenote. Music Recognition Service and MRS are service marks of 
Gracenote.

Adobe, the Adobe logo, Acrobat and Reader are either registered trademarks or trademarks 
of Adobe Systems Incorporated in the United States and/or other countries.

VST Plug-in Technology by Steinberg. Copyright © 2002 Steinberg Media Technologies 
AG. Steinberg is a registered trademark of Steinberg Soft- und Hardware GmbH. 

®
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Audio effect engine licensed by Algorithmix www.algorithmix.com. 

This software is based in part on the work of the Independent JPEG Group.

Ogg Vorbis audio compression technology provided courtesy of the Xiph.Org Foundation.

Some digital content © 1994-2002 Hemera* Technologies Inc. All Rights Reserved. * 
Trademark of Hemera Technologies Inc.

Monotype and Century Poster are trademarks of Monotype Typography Limited registered 
in U.S. Patent and Trademark Office and certain other jurisdictions. Creepy, Curlz, Falstaf, 
Figaro, Palace Script, Plump, M Gothic, M Mincho, and Team are trademarks of the 
Monotype Corporation and may be registered in certain jurisdictions. Adolescence is a 
trademark of Lunchbox Digital Typeface Library.

Banjoman is a trademark of Paul Veres. Bermuda and Wendy are trademarks of 
LetterPerfect Design. Eraser Dust is a trademark of Intecsas. Footlight is a trademark of the 
Monotype Corporation registered in the U.S. Patent and Trademark Office and may be 
registered in certain jurisdictions. KidType and Paint are trademarks of DS Design. Mistral 
is a trademark of Trip Productions BV. Orbus Multiserif is a trademark of Charles 
Anderson. Space Toaster is a trademark of Exploding Font Company.

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN 
Toolkit expressly disclaim all implied, express or statutory warranties including, without 
limitation, the implied warranties of merchantability, non-infringement of third party 
rights and fitness for a particular purpose. Neither the developers nor the distributors will 
be liable for damages, whether direct, indirect, special, incidental, or consequential, as a 
result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

All other company or product names are trademarks and/or registered trademarks of their 
respective owners.

Changes

The material in this document is for information only and is subject to change without 
notice. While reasonable efforts have been made in the preparation of this document to 
assure its accuracy, Roxio, Inc. assumes no liability resulting from errors or omissions in 
this document, or from the use of the information contained herein.
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Roxio reserves the right to make changes in the product design without reservation and 
without notification to its users.

Disclaimer

IF THIS PRODUCT DIRECTS YOU TO COPY MATERIALS, YOU MUST HAVE 
PERMISSION FROM THE COPYRIGHT OWNER OF THE MATERIALS TO AVOID 
VIOLATING THE LAW WHICH COULD RESULT IN DAMAGES OR OTHER 
REMEDIES.
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About DVD Builder
DVD Builder allows you to quickly create and burn DVD-Recordable and 
CD-Recordable discs that play back in most set-top DVD players and 
computers with DVD drives. 

DVD Builder is easy to use. Understanding the following concepts enables 
you to quickly begin using DVD Builder:

■ Import: To begin a project, you first bring in (import) the video clips 
and still images you want to include in your project. You can import 
directly from your camera (capturing), your hard disk, or other 
sources such as your scanner and digital camera.

■ Organize: Organizing allows you to arrange and sort your video clips 
and still images into movies and menus. Video clips and still images 
are organized into movies; and movies are organized into menus. Each 
project has one main menu. The main menu can have submenus, and 
submenus can have their own submenus.

■ Personalize/Edit: Give your project your own personal touch. You can 
trim and remove parts of a video clip you don’t want to use; record 
commentary to add to your clips and images; and even add music. Use 
the menu theme and transition libraries to create a mood that works 
perfectly for your project.

■ Burn: When you are ready to burn your discs, you have the option of 
burning to a DVD-Recordable disc, or to a CD-Recordable disc in the 
VCD (Video CD) or SVCD (Super Video CD) formats. You can also 
save your project to your hard disk as an image file and then burn that 
image file to disc at a later time.

Note  Refer to the Glossary for additional terminology.
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Starting DVD Builder

You can start DVD Builder in any of these ways:

■ From Easy CD & DVD Creator Home, click DVD Builder.

■ Choose Start Menu > Programs > Roxio Easy CD and DVD Creator 6 > 
DVD Builder.

The DVD Builder Work Area appears.

The DVD Builder Work Area
Here are the parts of the work area:

Screening Room Workshop

Import Buttons

Libraries Remote Control

Trash

Zoom

Add Submenu Disc Size Status Burn

Minimize
Maximize

Close

Menus
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Import Buttons
The Import buttons allow you to bring in the video clips and still images 

that you will use in your DVD Builder project. The following import 
options are available:

■  Video Capture: Import from the following sources:

■ Import digital video (DV) from a DV camcorder connected to 

your computer through an IEEE 1394 (FireWire) connector.

■ Import analog video from your VHS, 8mm, Hi8, or Beta tape 

sources. This requires a third-party analog capture card installed 

inside your computer. You can also import live video from your 

webcam.

■  Other Sources (digital still camera, scanner, and more): Import 
still images from devices such as digital still cameras, scanners, and 
webcams. These devices are typically TWAIN or WIA (Windows 
Image Acquisition) devices connected to your computer and turned 
on.

■  Multimedia Files: Import multimedia files already saved to your 
hard disk (or disc). The most common files you will import are video 
clips, still images, and audio.

■  Load Project From DVD VR Disc: Import the contents of a DVD 
VR disc into DVD Builder. This requires a DVD+RW recorder and 
DVD+RW disc that already contains a project in the DVD VR format 
(the DVD specification for Video Recording).

■  Real Time Recording: Import digital video directly from a DV 
source to a DVD. This requires a DVD+RW recorder and DVD+RW 
media.
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DVD Builder Menus
These menus allow you to access various commands available in DVD 

Builder.

Screening Room
The Screening Room allows you to capture video and play back menus, 

movies, video clips, or still images. It also allows you to change menu and 
button titles. Double-click a menu, movie, video clip, or still image in the 
Workshop (the right side of the DVD Builder work area) to display it in the 
Screening Room.

The default menu is shown below. The menu title, menu background, 
menu button, and button title can be changed to suit your project. The 
controls at the bottom allow you to control the playback of what is 
currently displayed in the Screening Room. There are different controls for 
capturing video and for previewing menus, movies, video clips, and still 
images.

Menu Title

Button Title

Menu Button

Playback Controls

Click to Play Motion

Menu Background
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Workshop
The Workshop is where you will arrange your project. It is where movies 

and submenus are created. It is also where you organize, sort, and apply 
transitions and music to your movies and menus. You can preview a 
movie, menu, video clip, or still image in the Screening Room by double-
clicking the item inside the Workshop.

■ Intro: The Intro is a movie that plays before the Main menu appears on 
your screen. For example, the FBI warning that plays on many DVD-
video discs commercially produced in the United States.

■ Movies: Movies are any combination of one or more video clips and 
still images used in your project. Movies are organized into menus.

■ Menus: Menus display one or more movies as buttons. Menus are 
made up of a background image, buttons, button titles, menu title, the 
menu itself, and associated background music. 

Each project contains a main menu to organize your movies. If you 
have several movies, you may want to organize them in a submenu.

Intro

Movie

Main Menu
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Each project can have only one main menu. The main menu can have 
submenus, and submenus can have their own submenus.

Zoom

The Zoom controls allow you to change the size of the menu and movie 
thumbnails displayed in the Workshop and various dialog boxes:

■ Click  to enlarge the size of the thumbnails.

■ Click  to reduce the size of the thumbnails.

The Library Drawer
The Library Drawer contains the following libraries:

■ Menu Theme: A wide variety of menu themes that you can apply to 
your menus.

■ Transition: A wide variety of transitions you can add to movies, video 
clips, and still images.

Burn

The Burn  button launches the Burn Project dialog box, which 

allows you to select your recording options and begin burning your project 
to a disc. You can also save your project to hard disk as an image file and 
then burn that image file to disc at a later time.

Menu Theme Transition
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Add Menu

The Add Menu  button allows you to create submenus. Each project 

can have only one main menu. The main menu can have submenus, and 
submenus can have their own submenus. If you have several movies, you 
may want to organize them in submenus.

Trash

Trash  allows you to remove unwanted files from your project:

■ To add a file to Trash, simply drag the file to Trash.

■ To delete the contents of Trash, right-click Trash and select Delete 
Trash.

■ To see the contents of Trash, click Trash. This allows you to retrieve 
clips from the “cutting room floor” to reverse your editing decisions or 
to make an “out-take” movie.

Note  If there are files in Trash, you are prompted to save them as 
part of the project when saving a DVD Builder project.

Remote Control

The Remote Control  allows you to preview (or simulate) your 

project without the time required to process the final version. This is a low 
quality preview designed to give you a quick way of viewing your project.
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Disc Size Status

The Disc Size Status displays the current size of your project for a specific 

disc format (DVD, VCD, SVCD). Clicking the Disc Size  icon allows 
you to select between the various disc formats.

Minimize, Maximize, and Close

These are standard application controls:

■ Minimize: Reduces DVD Builder to a button on the taskbar.

■ Maximize: Enlarges DVD Builder to its maximum size on the screen.

■ Close: Closes DVD Builder.
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Adjusting the DVD Builder Work Area
You can resize and move the work area to a size and location that suits 
your needs:

■ To resize the work area, drag the bottom right corner of the DVD 
Builder work area.

■ To move the work area around the screen, click and drag a free area on 
the DVD Builder work area (for example, the area just to the right of 
the Help menu).

Drag to Resize 
Work Area
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Adjusting the Workshop Zoom Size
You can change the size of the menu and movie thumbnails displayed in 
the Workshop and various dialog boxes:

■ Click  to enlarge the size of the thumbnails.

■ Click  to reduce the size of the thumbnails.

Saving and Opening a Project
You can save your project or open existing DVD Builder projects.

To save a project using a different name:

1 From the Project menu, select Save Project As. The Save Project dialog 
box appears.

2 Type a name for the project.

3 Click OK.

Note  After saving a project, do not move or delete the video clips 
and still images that are part of the project; otherwise, DVD 
Builder will not be able to find the video clip or still image when 
you open the project again.
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To overwrite the current project on the disk:

■ From the Project menu, select Save Project.

To open a project:

1 From the Project menu, select Open Project. The Open Project dialog 
box appears.

2 Select the name of the project from the drop-down list box.

3 Click OK.
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Setting Video Preferences
You can set preferences for selecting the video standard (NTSC or PAL) 
that you want to record to, for turning on the Video Quality Check dialog 
box, and for specifying the folder for captured video and temporary files.

To set video preferences:

1 From the File menu, select Preferences. The Video Preferences dialog 
box appears.

2 Set your preferences:

■ NTSC: Select this option if you want your project recorded to the 

NTSC (National Television Systems Committee) video standard. 

This is the standard used for broadcast television in the U.S., with 

a resolution of 525 horizontal lines at 30 frames per second.
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■ PAL: Select this option if you want your project recorded to the 

PAL (Phase Alternate Line) video standard. This is the standard 

used for broadcast television in much of Europe and Asia, with a 

resolution of 768 pixels × 576 horizontal lines at 25 frames per 

second.

■ Show Video Quality Check When Importing Files: Select this 

option when you want DVD Builder to determine whether the files 

you are importing are of acceptable quality for the type of disc you 

are burning your project to. Whenever you import a poor quality 

video clip or still image, a dialog box appears that reports the file 

you are attempting to import may not display well when you burn 

your project to a disc and view it on your TV. 

■ Specify a Folder for Captured Video: Displays the location where 

your captured digital and analog video is saved to. Click Browse to 

specify a different location.

■ Specify a Folder for Temporary Files: Displays the location where 

your temporary files are located. Click Browse to specify a different 

location.

■ Test Disk: Click this button to check the performance of the folder 

specified for captured streams. The test allows you to determine if 

the hard disk containing the folder you specified for captured 

streams is capable of adequately capturing video.
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Tips for Using DVD Builder
This section provides some tips for using DVD Builder.

Use a Large Size Hard Disk

Working with video clips and still images require lots of hard disk space. 
For example, capturing nine minutes of digital video (DV) tape requires at 
least 2 GB of free hard disk space. We recommend having the largest size 
hard disk possible.

Clean Up Your Capture Folder

The capture folder specified in the Video Preferences dialog box is where 
all of your captured video is stored. Over time, the capture folder may 
accumulate an excessive amount of video that is not being used, which may 
affect your ability to capture additional video and record your project. We 
recommend periodically cleaning up the folder by removing unused video 
clips. To determine the location of the capture folder, access the Video 
Preferences dialog box by selecting Preferences from the File menu.

Note  Only remove video clips that are not used or are no longer 
needed in a DVD Builder project. If you remove a video clip that is 
used in one of your projects, DVD Builder will not be able to locate 
the clip the next time the project is opened.

Defragment Your Hard Disk

It is a good idea to defragment your hard disk on occasion to make sure it 
has a clean continuous place for your captured video. Refer to your 
Windows documentation for details.

Turn off Energy Saving Features of Your PC While Working With Video

When capturing video or burning a disc, it’s a good idea to make sure that 
the Windows energy saving features and screen savers are turned off. These 
features may interfere with the capturing and burning processes. Refer to 
your Windows documentation for details.



Easy CD & DVD Creator 6 Expanded User’s Guide: DVD Builder
Chapter 1: Introduction 16

ECDC_6_0_UserGuide_DB.book  Page 16  Monday, December 16, 2002  1:52 PM
Import Everything at Once

If you have all your video clips and still images available, you can import 
them into your project all at once and then organize them later. See Why 
Organize Movies into Menus? on page 65.

Viewing Boundary Colors

The main menu, submenus, and movies in the Workshop are identified by 
a boundary color. The colors allow you to visually see relationships 
between movies and menus. If a movie or submenu belongs to a particular 
menu, the boundary color of the parent menu is visible to the immediate 
left of the movie or submenu. See Creating a Submenu on page 66.

Video from the Internet

Most video files available on the Internet today are optimized for quick 
downloading and are in formats designed for viewing on your computer 
monitor instead of a television screen. If you use these files in your project, 
keep this limitation in mind. DVD Builder displays a warning dialog box 
whenever you try to import poor quality files. Read the warning dialog box 
to see if the file is acceptable for the type of disc (VCD, SVCD, or DVD) 
you are burning your project to.

Poor Quality Video Cannot Be Improved by Burning It to a DVD

Burning a DVD disc does not improve the quality of the video clips and 
still images you import into your project. If the quality of the clips and 
images is poor when you import them into DVD Builder, then the quality 
of the final video on DVD will also be poor.

DVD Builder provides a De-noiser filter which may improve the picture 
quality of video clips that originated from a VHS source and are of poor 
quality (for example, foggy or grainy clips). See Applying the De-noiser 
Filter to Movies, Video Clips, or Still Images on page 61.

Use Menus and Submenus to Organize Your Movies

Viewers will find your DVD easier to navigate and enjoy if your movies are 
organized into common subject matter using menus and submenus. 
Consider dividing your longer movies into several short movies reached 
from one main menu. This technique allows your viewer to watch your 
DVD in a more interactive manner. For example, a viewer can choose to 
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watch either the ceremony or reception of a wedding. See Why Organize 
Movies into Menus? on page 65.

Create an Intro Movie

Creating an intro movie will also help draw your viewers into the menu 
system and engage them in the DVD experience. See Changing the Default 
Intro Movie on page 51.

Add Transitions

Transitions are the visual changes from one clip to another. Transitions are 
fun to play with but more importantly they act as a type of punctuation 
when watching a movie. Placing a dissolve transition between two clips, for 
example, will give your audience a feeling that time has passed between one 
clip and the next. Or, having a clip dissolve into a solid black image is like 
ending a paragraph or chapter and indicates a break in thought or time. 
See Adding a Transition on page 79.

Shoot Extra Footage

When shooting events or travel, try to get some extra footage of people’s 
reactions. Later, when putting your movie together, you can use the extra 
footage to break up long steady shots and make things more interesting. 
People like to watch people. It’s always a good idea to break up shots of 
beautiful locations with reactions of the people that are enjoying it. 
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Making Your First DVD with DVD Builder
This section shows you how easy it is to transfer raw video from your DV 
camcorder to your computer, personalize the footage in DVD Builder, and 
burn it to a disc that can be played in almost any set-top DVD player.

There are the four simple steps to this process:

■ Capture: Import video into your computer’s hard disk from your DV 
camcorder.

■ Personalize: Use menus to assemble your captured video clips into a 
DVD Builder project.

■ Preview: Use the Remote Control tool to simulate your project as it 
might appear when viewed on a set-top DVD player.

■ Burn: Record your project to disc.

Before You Begin
Make sure you have these items:

■ DVD Builder installed on your computer

■ DVD recorder connected to or installed in your computer. To burn a 
DVD you will need a DVD-R, DVD-RW, DVD+R, or DVD+RW 
recorder.

■ DVD recordable disc. For a list of recordable media compatible with 
your recorder, see the recorder’s documentation.

■ DV camcorder connected to a 1394 Firewire port on your computer

■ DV tape (containing your video footage) in your DV camcorder
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Step One: Capture Video From Your DV 
Camcorder
This section describes how to easily import (or capture) video from a DV 
camcorder into your computer’s hard disk.

To capture video:

1 With your camcorder connected to your computer via a 1394 Firewire 
cable, turn it on and switch it to VCR mode.

2 Start DVD Builder. (To start the application, from the Easy CD Creator 
Project Selector window, click Make a Video Disc, then click DVD 
Builder.) The DVD Builder main work area appears.

Screening Room Workshop

Import Buttons

Remote Control

Thumbnail Zoom

Add Menu BurnMenu Theme Library

Transition Library
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3 Click the Video Capture  button. The controls for capturing video 
appear in the Screening Room, the left side of the DVD Builder work 
area.

4 Use the playback controls to control your DV camcorder and to go to 
the part of the videotape that you want to capture.

5 Click Play  to start streaming video to the Screening Room.

Playback Controls

Start Capture/
Stop Capture

Screening Room

Fast Tape Rewind Play Fast Tape Forward

Stop Pause
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6 To start capturing video, click Start Capture while video is actively 
streaming from the camcorder. 

The button turns into the Stop Capture button, and the captured video 
begins recording to your hard disk.

7 To stop capturing video, click Stop Capture. The captured video is 
added to the highlighted movie in the Workshop to the right. Each 
thumbnail in the movie is a separate video clip.

You can “Start Capture” and “Stop Capture” as often as you like. Each 
time you “Start Capture” and “Stop Capture,” another video clip is 
added to the Movie.

8 Repeat Steps 5 through 7 for each segment of video you want to 
capture.

Note  To preview any video clip you just captured in the 
Screening Room, double-click it in the Workshop.

Click Start Capture to
Start Capturing Video

Turns Red to Indicate
Video Capture in Progress

Example of Four 
New Video Clips
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Step Two: Personalize Your Project
Once you have captured video to a movie in the Workshop, you can 
proceed directly to Step Four: Burn Your Project to Disc on page 30; 
however, we recommend personalizing your project by following any of the 
procedures in this section:

■ Change the Menu Background

■ Rename the Menu and Button Titles

■ Add Transitions

■ Add a Submenu

■ Rearrange the Order of Your Video Clips

Change the Menu Background
You can change the background of the default menu to a background that 

is more suitable for your project.

To change the menu background:

1 Double-click the Main Menu in the Workshop. The menu displays in 
the Screening Room. 
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2 Click Menu Theme Library  in the DVD Builder Library Drawer. 
The Menu Theme Library opens.

3 Drag the desired menu theme from the Menu Theme Library to the 
menu in the Screening Room (or to the menu in the Workshop). The 
new background appears in the menu. 

Menu Theme Library
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Rename the Menu and Button Titles
You can rename the menu and button titles with more descriptive names 

for your video footage.

To rename a menu and button title:

1 Double-click the Main Menu in the Workshop. The menu displays in 
the Screening Room. 

)

2 Click either the menu or button title.

3 In the dialog box that appears, type a new name.

4 Click OK.

Menu Title

Button Title
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Add Transitions
You can add transitions to show stylistic changes from one video clip to 

another (for example, one video clip “dissolving” into the next). 

To add a transition:

1 Click Transition Library  in the DVD Builder Library Drawer. The 
Transition Library opens.

2 Drag the desired transition from the Transition Library to the 
transition holder of the video clip (or to the movie handle to apply the 
transition to everything in the movie).

Transition Library

Transition Holder 
(empty)

Transition Holder (Turns Yellow 
When Transition is Added)
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Add a Submenu
If your project has several movies, you can use submenus to organize and 

sort your movies.

To add a submenu:

■ Click Add Menu . The default submenu appears in the Workshop 
slightly indented from the menu it belongs to and surrounded by a 
boundary color.

Note  The main menu, submenus, and movies in the Workshop 
are surrounded by a boundary color. The colors allow you to 
visually see relationships between movies and menus. If a movie or 
submenu belongs to a particular menu, the boundary color of the 
parent menu is visible to the immediate left of the movie or 
submenu.

Main Menu Submenu (Slightly Indented
from Main Menu)

Main Menu 
Boundary Color

Submenu 
Boundary Color

Movie Boundary 
Color
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Rearrange the Order of Your Video Clips
You can rearrange video clips in your movie to change the order of how 

they appear.

To rearrange video clips:

■ Drag the video clip to before or after another video clip in the movie.

Note  You can also to a different location in the Workshop. For 
example, to other movies, to an “Empty Video” holder, to menus, 
or to Trash.

Step Three: Preview Your Project Before You 
Burn
Before you burn your project to disc, you can preview your project as it 
would appear when viewed on your TV. This is a low quality preview 
designed to give you a quick way of viewing your project.

To preview your project:

1 Click the Remote Control  icon.

A preview begins, with the remote control displayed on the right of the 
screen.
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2 Use the remote control to navigate through video and menus in your 
project. You can also click a menu button within the preview screen to 
view the movie attached to it.

3 To close the preview and return to the DVD Builder work area, click 
Stop Preview (the X in the top right-hand corner of the remote control 
icon).

Step Four: Burn Your Project to Disc
Once you are satisfied with your project, your final step is to burn it to disc.

To burn your project to disc:

1 Insert a DVD-recordable disc into your recorder.

2 Click the Burn  button. The Burn Project dialog box appears.

3 Make sure to do the following:

■ From the Destinations drop-down list, select the DVD recorder 

that you want to use to burn your project.

Play Buttons

Special Menu Buttons

Menu Navigation Buttons

Close Preview
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■ Under Output disc type, select DVD.

4 Click OK.

Different dialog boxes will display the progress of encoding each movie 
in your project, as well as burning the final project to disc. Encoding 
and burning may take some time.

Finally, a message appears to tell you that your project is successfully 
burned to disc. Congratulations! You have just burned your first DVD 
with DVD Builder.

Select the DVD Recorder

Select DVD
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Start Your Project by Importing Video Clips 
and Still Images
Each project begins by first bringing in (importing) the video clip and still 
image sources from your DV camcorder, analog tape source, hard disk, or 
other device. You can also import audio files; however, this is optional 
when you first begin a project.

Note  You can import all your video clips and still images all at 
once and then organize them later. See Why Organize Movies into 
Menus? on page 65.

Note  Roxio VideoWave Movie Creator Users: You can import 
your finished Movie Creator movies into DVD Builder to organize 
and burn them to DVD. Refer to your VideoWave Movie Creator 
User’s Guide for information on making movies that are ready for 
DVD.

Importing Digital Video
You can import digital video to your hard disk by “capturing” it directly 
from your DV camcorder.

To capture digital video:

1 Make sure your camcorder is connected to your computer and turned 
on to VCR mode. (Refer to your camcorder’s documentation for 
instructions.)

Note  You can capture live video from your DV camcorder by 
setting the camcorder to Camera mode.
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2 Click the Video Capture  button. The controls for capturing video 
appear in the Screening Room, the left side of the DVD Builder work 
area.

3 Use the playback controls to control your DV camcorder and to go to 
the part of the videotape that you want to capture.

4 Click Play  to start streaming video to the Screening Room. 

Playback Controls

Start Capture/
Stop Capture

Fast Tape Rewind

Play

Fast Tape Forward

PauseStop
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5 To start capturing video, click Start Capture while video is actively 
streaming from the camcorder. The button turns into the Stop 
Capture button, and the captured video begins recording to your hard 
disk.

6 To stop capturing video, click Stop Capture. The captured video is 
added to the highlighted movie in the Workshop to the right. Each 
thumbnail in the movie is a separate video clip.

7 Repeat Steps 4 through 6 for each segment of video you want to 
capture.

You can “Start Capture” and “Stop Capture” as often as you like. Each 
time you “Start Capture” and “Stop Capture,” another video clip is 
added to the Movie. 

8 To preview the video clip you just captured, double-click it in the 
Workshop.

Note  You can change digital video capture settings by clicking 
Advanced Settings.

Turns Red to Indicate
Video Capture in Progress
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Importing Analog Video
You can import analog video to your hard disk by “capturing” it directly 
from your VHS, 8mm, Hi8, or Beta tape sources. This requires a third-
party analog capture device installed on your computer. (Refer to your 
capture card documentation for instructions.)

Note  You can also capture live video from a webcam; however, 
this type of video does not produce a high-quality picture when 
burned to a disc and viewed on your TV.

To capture analog video:

1 Click the Video Capture  button. The import controls for 
capturing video appear in the Screening Room. If a DV camcorder and 
analog device is connected, you will need to select your analog device 
as the video capture source.

Advanced Settings

Start Capture/
Stop Capture

Playback Buttons 
are Not Active for 
Analog Capture
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2 Click the Advanced Settings button. The Advanced Settings dialog box 
appears.

3 You can select from the following settings in this dialog box:

■ Select Source: Select the analog device that you want to capture 

video from.

The Format, Inputs, Tuner, and Display buttons below are enabled 
or disabled depending on the type of device you selected. For more 
information, click Help on the dialog box.

■ Select Audio Source: Select the analog device that you want to 

capture audio from.

Note  Most of the time, you probably will want to capture audio 
and video together from the same analog device (for example, 
from a videotape in your VCR). In some circumstances, however, 
you may want to capture video and audio from different devices. 
For example, perhaps you are capturing video from a webcam that 
has no sound recording ability and you want to capture a 
soundtrack from another device at the same time.

Select Source 
Drop-down List Box

Select Audio 
Source Drop-down 
List Box
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If you choose different audio and video analog devices that you 
want to capture from, the audio and video are married (blended 
together in each captured video clip).

■ Create chapters every (hh:mm:ss): Check this box if you want DVD 

Builder to automatically separate streaming analog video into 

more than one video clip. Enter the exact length of time each clip 

lasts before a new one is created.

For example, 00 01 45 will create a new video clip every one 
minute forty-five seconds.

4 Click OK. 

5 Press the playback button on your analog device to start streaming 
video to the Screening Room.

If you selected a different analog device to capture audio from, you 
must also press the playback button on the second analog device to 
start streaming audio to the Screening Room.

6 To start capturing video, click Start Capture while video is actively 
streaming from the device. The button turns into the Stop Capture 
button, and the captured video begins recording to your hard disk.

7 To stop capturing video, click Stop Capture. The captured video is 
added to the highlighted movie in Workshop.

Turns Red to Indicate
Video Capture in Progress
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8 Repeat steps 6 and 7 for each segment of video you want to capture.

You can “Start Capture” and “Stop Capture” as often as you like. Each 
time you “Start Capture” and “Stop Capture,” another video clip is 
added to the movie. 

9 To preview the video clip you just captured, double-click it in the 
Workshop.

Importing From Other Sources (Digital Still 
Camera, Scanner, and More)
You can import still images from other sources such as a digital still 
camera, scanner, or webcam. These devices are typically accessed through a 
TWAIN or WIA (Windows Image Acquisition) interface.

To import from other sources:

1 Make sure the device is connected to your computer and turned on. 
(Refer to your device’s documentation for instructions.)

2 Click the Other Sources  button. If more than one device is 
detected, the Select Source dialog box appears.

3 Select the device you that want to import from and click OK. 
Depending on the device you selected, a TWAIN or WIA interface 
appears. Acquire the still images from the device as you normally 
would. Images acquired from the device are automatically added to the 
Workshop.

Note  The TWAIN or WIA interface varies from device-to-device. 
Refer to your device’s documentation for instructions on 
acquiring still images from these devices.

4 To preview a still image, double-click it in the Workshop.
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Importing Multimedia Files
You can import a wide variety of multimedia files saved on your hard disk, 
an audio CD, or a data disc. The most common files you will import are 
video clips, still images, and audio.

To import multimedia files:

1 Click the Multimedia Files  button. The Import Files dialog box 
appears.

Note  You can display various file types and views by clicking the 
icons in the dialog box. The drop-down list box allows you to 
display files by file type.

2 Navigate to the folder where your files are located; only files that can be 
imported are displayed in the right pane.

Note  To preview a file, you can double-click it in the dialog box.
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3 Do one of the following:

■ Drag the file(s) that you want to import to the Workshop. 

Continue with Step 4 below.

■ Highlight the file you want to import and click OK. The dialog box 

closes and the file is added to the highlighted movie in the 

Workshop.

4 Click OK to close the Import Files dialog box.

Note  You can also import a valid multimedia file by dragging the 
file from Windows Explorer directly to the Workshop.

Valid Multimedia File Formats
Here are the file formats you can import into DVD Builder:

File Type Description

video files Displays valid video files only.

audio files Displays valid audio files only.

still images Displays valid still image files only.

*.avi Audio Video Interlaced (AVI). These are video files that 
may contain audio.

*.mpg MPEG-1 Program Stream. These are video files that may 
contain audio.

*.dat VCD-compliant video files with extensions files. These 
are video files that may contain audio.

*.mpeg MPEG movie or animation. These are video files that 
may contain audio.

*.m2p MPEG-2 Program Stream. These are video files that may 
contain audio.

*.svd SVCD-compliant video data (generally MPEG2). These 
are video files that may contain audio.

*.vob DVD-compliant MPEG-2 program stream. These are 
video files that may contain audio.
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Load Project From DVD VR Disc
If you have an existing DVD+RW disc that already contains a video project 
recorded in the DVD VR format (the DVD Specification for Video 
Recording), you can load the contents of the disc into the Workshop. Once 
loaded into the Workshop, you can change the project’s menu, delete 
movies, and use Real Time Recording to add movies to the disc.

Note  The Load Project From DVD VR Disc feature works in 
conjunction with the Real Time Recording feature and requires a 
DVD+RW recorder. 

To load a project from a DVD VR disc:

1 Insert the DVD VR disc into your DVD+RW Recorder and allow the 
disc to mount.

2 Click the Load DVD VR Disc  button. The contents of the DVD 
VR disc is loaded into the Workshop.

*.wmv Windows Media Video. These are video files in the 
native Windows XP video format.

*.divx These are AVI videos containing DivX encoded video.

*.mov QuickTime movie. These are video files that may 
contain audio.

*.wav WAVE files. These are audio files.

*.mpa MPEG Audio Stream. These are audio files.

*.mp3 MPEG-1 Audio Layer 3. These are audio files.

*.mp2 MPEG-2 Audio Data. These are audio or video files.

*.aif Audio Interchange File. These are audio files.

*.wma Windows Media Audio. These are audio files.

*.bmp Bitmap. These are still image files.

*.jpg JPEG (Joint Photographics Experts Group). These are 
still image files.

File Type Description
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3 To add movies to the disc, use Real Time Recording. See Real Time 
Recording on page 44.

Note  If you append to or delete from the project, any menu that 
existed in the original project is replaced by the default DVD 
Builder menu. Also, if you delete a movie from the project, the 
movie is permanently removed from the project and cannot be 
recovered.

Real Time Recording
You can record video from a DV camcorder directly to a disc using Real 
Time Recording. This allows you to burn your project to disc without 
having to first capture your video to hard disk. Real Time Recording is 
especially useful when you want to quickly transfer your video tape to disc.

To use Real Time Recording, you must have a DVD+RW recorder and 
DVD+RW media. The media can be a blank DVD+RW disc, an existing 
DVD+RW disc that already has content (you will be prompted to 
overwrite it), or a DVD+RW disc that already contains a DVD VR project.

Note  If you want to record to an existing DVD+RW disc that 
already contains a DVD VR project, first load the contents of the 
disc into the Workshop by using Load Project From DVD VR 
Disc. See Load Project From DVD VR Disc on page 43.

To record video using Real Time Recording:

Note  Real Time Recording requires a significant amount of 
system resources in order to process video without dropping 
frames. We recommend closing all other opened applications, 
especially any DVD software players, before proceeding.

1 Insert a DVD+RW disc into your DVD+RW recorder.
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2 Click the Real Time Recording  button. The Real Time Recording 
Devices dialog box appears. 

3 Select the DV capture device and the destination device, and click OK. 
The controls for capturing video using Real Time Recording appear in 
the Screening Room.

Playback Controls

Start Capture/
Stop Capture
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4 Use the playback controls to control your DV camcorder and to go to 
the part of the videotape that you want to capture.

5 Click Play  to start streaming video to the Screening Room. 

6 To start capturing video, click Start Capture while video is actively 
streaming from the camcorder. The button turns into the Stop 
Capture button, and the captured video begins recording to your disc.

7 To stop capturing video, click Stop Capture. 

Allow DVD Builder to finish encoding the menu and updating the File 
System on the disc. A progress bar allows you to follow the progress of 
the encoding and updating process.

Note  When using some DVD+RW media, you can shorten the 
burn process by enabling the Quick Eject feature. If Quick Eject is 
enabled, the disc may not be playable in some set-top DVD players 
and most DVD ROM drives. To ensure compatibility with most 
players and drives, leave Quick Eject disabled (the default). If you 
want to enable Quick Eject, click Advanced Settings in the 
Screening Room and select Quick Eject.

8 When the encoding and updating process is completed, the following 
dialog appears and the captured video is added to the highlighted 
movie in the Workshop to the right.

Fast Tape Rewind

Play

Fast Tape Forward

PauseStop

Turns Red to Indicate
Video Capture in Progress
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9 Repeat Steps 5 through 8 for each segment of video you want to 
capture.

You can “Start Capture” and “Stop Capture” as often as you like. Each 
time you “Start Capture” and “Stop Capture,” another video clip is 
added to the Movie. 
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What is a Movie in DVD Builder?
A movie is one or more video clips or still images that you assemble 
together. When you play the movie, the video clips and still images appear 
as one continuous sequence. Any combination of video clips and still 
images can be used in a movie. You create and organize your movies inside 
menus in the Workshop. 

Each movie consists of a movie title, video clips and still images, and a 
boundary color that easily identifies the movie and its contents. You can 
also apply transitions and add sounds to a movie, or to the various video 
clips or still images inside a movie.

Creating a Movie

There are several ways to create a movie:

■ Capturing digital or analog video creates a new movie.

■ Dragging a video clip or still image from Windows Explorer to an 
empty movie in the Workshop creates a new movie.

■ Selecting the Multimedia Files  button and dragging a video clip 
or still image to an empty movie in the Workshop creates a new movie.

Movie Title Video Clip

Movie Handle

Transition Holder

Boundary Color
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Changing the Default Intro Movie
An Intro Movie is a movie that plays before the Main menu appears on 
your screen. For example, the FBI warning that plays on many DVD-video 
discs commercially produced in the United States.

DVD Builder provides a default intro movie for each project. You can add 
more video clips or still images to the default intro movie, or you can 
replace the default intro movie with another video clip or still image.

To add another video clip or still image to the Intro movie:

■ Drag a video clip or still image to Intro movie.

To replace the default Intro Movie:

1 Delete the default intro movie by dragging the video clip named 
“RoxioIntro.avi” to Trash.

2 Drag a different video clip or still image to Intro.

Note  If “Intro” is left empty, the main menu is the first thing that 
appears when playing a disc in your set-top DVD player.
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Renaming a Movie Title
The default name for each movie you create begins with “Movie X,” where 
X is the letter of your movie. You can rename a movie with a more 
descriptive title. For example, “Road to Hana.” 

To rename a movie title:

1 Right-click the movie handle in the Workshop and select Rename.

2 Type a new name and press Enter.

Note  Renaming a movie title renames its corresponding button 
title inside the menu. Inversely, renaming a button title renames 
its corresponding movie title inside the Workshop. See Renaming a 
Button Title on page 70.

Selecting and Moving a Movie
The movie handle of a movie allows you to select and move a movie. 
Typically, you move movies when you want to organize them under a 
different menu, change the order of how they appear under a menu, 
remove them from a menu, drag them to Trash, or preview them.

To move a movie:

■ Drag the movie handle to the new location within the Workshop or to 
the Screening Room.

Note  Moving a movie to a different position under a menu 
changes the position of the movie’s button on the menu.

Movie Handle
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Selecting and Moving Parts of Movie
You can select and move parts of a movie (the individual video clips and 
still images) to other movies, to an “Empty Video” holder, to menus, to 
Trash, and to the Screening Room.

To move parts of a movie:

■ Drag the video clip or still image to the new location within the 
Workshop or to the Screening Room.

Removing a Video Clip or Still Image from a 
Movie
You can remove the individual video clips and still images from a movie.

There are two ways to remove a video clip and still image:

■ Right-click the video clip or still image and select Delete.

■ Drag the video clip or still image to Trash, another movie, or to a 
menu (effectively creating a new movie).

Previewing the Movie
You can preview a single movie or parts of a movie. Previewing a movie 
also allows you to remove unwanted clips from the movie and record 
audio as commentary.

To preview a movie or parts of a movie:

■ To preview a single movie, double-click the movie handle. The movie 
automatically plays in the Screening Room.

■ To preview the individual video clips of a movie, double-click the 
video clip. The video clip plays in the Screening Room.

■ To preview a still image of a movie, double-click the still image. The 
still image displays in the Screening Room.
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Trimming Video Clips
You can trim a video clip to remove unwanted portions of the clip, or you 
can split a video clip into two clips. 

To trim a video clip:

1 Double-click the video clip in the movie. The video clip plays in the 
Screening Room.

2 Use the slider or playback controls to go to the part of the video clip 
you want to trim or split. The time counter displays the time of the 
current location within the video clip.

3 Click one of the following:

■ Trim Left: Removes everything to the left of the current location; 

the discarded portion is added to Trash.

■ Split Video: Splits the clip into two clips at the current location. 

The two clips are added to the movie; the original clip is added to 

Trash.

■ Trim Right: Removes everything to the right of the current 

location; the discarded portion is added to Trash.

Slider Control

Trim Left Trim RightSplit Video

Playback Controls Time Counter
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Note  To restore a video clip to its original state before it was 
trimmed/split, right-click the video clip in the Workshop and 
select Undo Trim/Split.

Deleting Movies
You can delete movies from the Workshop. This removes the movie from 
the Workshop but does not affect the original video clip or still image file.

There are two way to delete a movie:

■ Drag the movie handle to Trash.

■ Right-click the movie handle and select Delete.

Setting the Duration of a Still Image
You can specify the amount of time (duration) a still image displays in a 
movie before switching to the next video clip, still image, or movie.

To set the duration for a still image:

1 Right-click the still image in the Workshop and select Duration.

2 Select from one of the pre-defined durations (you can select 1, 3, 6, 10, 
or 15 seconds).

Rotating a Still Image
You can rotate a still image so that it displays in the proper orientation.

To rotate a still image:

1 Right-click the still image and select Rotate.

2 Select from one of the pre-defined rotation options.

You can select 90° to rotate the image clockwise by 90 degrees, or -90° 
to rotate the image counter-clockwise by 90 degrees.
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Extracting a Frame From a Video Clip
You can select a single frame of a video clip and save it as a .bmp graphic 
file.

To extract a frame:

1 Right-click the video clip and select Extract Frame. The Select Frame 
dialog box appears and begins playing the video clip.

2 Use the slider or playback controls to go to the part of the video clip 
you want to extract.

3 Click OK. The selected frame is extracted and added as .bmp file to the 
movie.

Adding Sound to a Movie, Video Clip, or Still 
Image
You can add one audio file at a time to a movie, video clip, or still image. 
You could use audio, for example, to add music as a background for a 
video about your vacation to Maui.

Note  An audio file added to a movie, video clip, or still image 
always starts playing at the beginning of the movie, video clip, or 
still image.

If a movie or video clip already comes with an audio track, you must 
choose one of the following options when attaching new audio:

■ Blend the sound so the original and new audio play together.

■ Replace the original audio with the new audio. (This does not destroy 
the original audio—you can restore the original audio by removing the 
new audio.)
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Note  When working with movies that contain video clips only, it 
is generally a good rule to add audio that is shorter than (or equal 
in length to) the movie or video clip. If the sound is longer, it will 
be cut off when the movie or video clip ends. (If the sound is 
longer than a movie that contains still images, you can stretch the 
still images to fit the sound length. For more information, see 
Stretching Image Duration to Fit Sound Length on page 58.)

There are several ways to add an audio file:

■ Click the Multimedia Files  button and drag an audio file from 
the Import Multimedia dialog to the movie handle, video clip, or still 
image in the Workshop. (To sort your multimedia files by audio file, 

click the Audio Files  button.)

■ Right-click the movie handle, video clip, or still image in the 
Workshop and select Attach Audio. Select the audio file in the Browse 
dialog box that appears.

■ Drag an audio file from Windows Explorer directly to the movie 
handle, video clip, or still image in the Workshop.

Note  A note symbol on the movie, video clip, or still image in the 
Workshop indicates an audio file is attached.

Note Symbol
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Ripping Audio to a Movie, Video Clip, Still 
Image, or Menu
You can drag audio files directly from an audio disc onto movies, clips, still 
images, or menus, where DVD Builder converts them to .wav files and 
attaches them to the item you dragged to. This is called ripping.

Note  If you want to add .mp3 files from an MP3 disc into your 
movies, video clips, or still images, we recommend that you first 
copy those files from the MP3 disc to your hard disk, then use the 
Import Multimedia button to add the audio to your project.

For information on importing audio files into your project, see Adding 
Sound to a Movie, Video Clip, or Still Image on page 56.

Stretching Image Duration to Fit Sound Length
If an audio file is longer than a movie that you have added it to, you can 
automatically stretch the durations of the still images in the movie so that 
the movie length equals the audio length.

Note  This option applies only if the movie contains at least one 
still image.

To stretch still images to fit sound length:

■ Right-click the movie handle, and select Stretch Still Image Duration to 
Fit Sound Length.
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Recording Commentary
You can record commentary for a movie, video clip, or still image. You 
might want to use commentary to give background narration to your 
project.

Selecting the Recording Device
If you have more than one recording device connected to your computer, 
you can select which device you want to use to record commentary. For 
example, you might want to alternately record from a microphone and a 
webcam.

To select the recording device:

1 Make sure at least one recording device (such as a microphone) is 
securely connected to your computer.

Note  For information on connecting a third-party recording 
device, refer to the instructions that came with the device.

2 From the Device drop-down list, select the recording device you want 
to use.

Recording Commentary
When recording commentary, the commentary playback will always start 
at the beginning of the movie, video clip, or still image that you are adding 
it to.

If you want commentary to start at any point between the start and end of 
the clip, you must first split the clip as described in Trimming Video Clips 
on page 54.

To record commentary:

1 Make sure you have selected the device that you want to record with.

2 Double-click the movie handle, video clip, or still image to display it in 
the Screening Room:
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3 To start recording, click Microphone  and speak into the 
microphone.

4 When you are finished, click Microphone  to stop 
recording.

Note  Commentary recording automatically stops when the 
movie, video clip, or still image duration ends.

DVD Builder automatically attaches the recording to the movie, video 
clip, or still image.

Previewing Recorded Commentary

To preview recorded commentary:

■ Double-click the movie, video clip, or still image that you just added 
commentary to.
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Removing Sound from a Movie, Video Clip, or 
Still Image
There are two ways to remove an audio file or recorded commentary from 
a movie, video clip, or still image:

■ Right-click the note symbol  on the movie, video clip, or still 
image and select Remove.

■ Right-click the movie, video clip, or still image and select Remove 
Audio.

Note  If you want to restore commentary you just removed from a 
movie, video clip, or still image, it is not gone forever! DVD 
Builder stores each recording in the Capture folder with the name 
ComX.wav, where X represents the number of the file. For 
example, the first file you record is Com1.wav, the second file 
Com2.wav, and so forth. The default location of the Capture 
folder is C:\Program Files\Roxio\DVD Builder.

Applying the De-noiser Filter to Movies, Video 
Clips, or Still Images
You can use the De-noiser filter to improve the picture quality of video 
clips that originated from a VHS source and are of poor quality (for 
example, foggy or grainy).

To apply the De-noiser filter:

■ Right-click the movie or video clip and select De-noiser.

A De-noiser symbol on the video clip in the Workshop indicates the 
De-noiser filter is applied.
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Note  You cannot view the results of the De-noiser filter until you 
burn your project to disc and view the disc on a television screen.

De-noiser Symbol
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What is a Menu?
With DVD Builder, you can create menus that work exactly like the menus 
you see when you play a DVD-video disc you rent or buy from your local 
video store. These menus typically allow you to play the movie, set audio 
settings, view bonus material, etc.

In DVD Builder, each menu is made up of a background image (a short 
video clip or still image), menu titles, buttons for each movie, button titles, 
and even sound.

Note  The Theme Library allows you to select different menu 
themes for your menus. See Choosing a Menu Theme on page 76.

Background
Image

Menu Title Button TitleMenu Button
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Why Organize Movies into Menus?
Your project may consist of several movies. You can use menus to help you 
organize and sort your movies. 

Here is an example of how you might want to use menus to organize the 
video clips and still images from your wedding day:

■ First, you would import the video clips and still images into DVD 
Builder. This results in several different movies created in the 
Workshop.

■ Next, you would create a menu titled “Our Wedding Day” Inside this 
menu, you could have three different movies titled “Getting Ready,” 
“The Ceremony,” and “The Reception.”

■ Furthermore, if you also had video from your honeymoon, you could 
create a submenu titled “Our Honeymoon in Maui.” This menu could 
have three different movies titled “The Road to Hana,” “Sunrise at 
Haleakala,” and “The Beach at Kaanapali.”
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As you can see, you can get very creative organizing movies into menus. 
And it’s all very easy to do inside the Workshop—simply create your 
menus and add your movies to them.

Note  To better see how a menu is organized, preview the menu. 
Previewing a menu also allows you to change menu titles. See 
Previewing a Menu on page 67.

Creating a Submenu
Each project always contains a main menu to organize your movies. If you 
have several movies, you may want to organize them in a submenu.

Each project can have only one main menu. The main menu can have 
submenus, and submenus can have their own submenus.

To create a submenu:

■ To create a submenu, click Add Menu . The default submenu 
appears in the Workshop slightly indented from the menu it belongs to 
and surrounded by a boundary color.
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Note  The main menu, submenus, and movies in the Workshop 
are surrounded by a boundary color. The colors allow you to 
visually see relationships between movies and menus. If a movie or 
submenu belongs to a particular menu, the boundary color of the 
parent menu is visible to the immediate left of the movie or 
submenu.

Previewing a Menu
You can preview menus to see the background image, menu title, and 
buttons of a menu more closely. Previewing a menu also allows you to 
rename menu and button (movie) titles.

To preview a menu:

1 Double-click the menu in the Workshop. The menu displays in the 
Screening Room.

Main Menu Submenu (slightly indented
from Main Menu)

Main Menu 
Boundary Color

Submenu 
Boundary Color

Movie Boundary 
Color
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2 If the menu is a motion menu, you can click Play  to start the 
motion.

Adding Movies to a Menu
You add movies to your menus to create selectable menu buttons.

Note  Movies and menus inside the Workshop have a boundary 
color that allows you to easily identify which movie belongs to 
which menu. If a movie belongs to a particular menu, the 
boundary color of the parent menu is visible to the immediate left 
of the movie.

There are several ways to add a movie to a menu:

■ Drag the movie handle of a movie to the desired menu in the 
Workshop. 

■ Drag part of an existing movie (video clip or still image) to the desired 
menu (or an empty movie) in the Workshop. This creates a new movie 
on the menu.

Main Menu 
Boundary Color

Submenu 
Boundary Color

Movie Boundary 
Color
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■ Drag a video clip or still image file from Windows Explorer directly to 
the desired menu (or an empty movie) in the Workshop. This creates a 
new movie on the menu.

■ Click the Multimedia Files  button and drag a video clip or still 
image file to the desired menu (or an empty movie) in the Workshop. 
This creates a new movie on the menu.

■ Right-click a movie handle in the Workshop, select Attach to Menu, 
then select the menu that you want to add the movie to.

Renaming a Menu Title
You can rename a menu title with a more descriptive name (for example, 
“Our Caribbean Cruise”).

To rename a menu title:

1 Double-click the menu in the Workshop. The menu appears in the 
Screening Room.

2 Click the menu title in the Screening Room.

3 Type a new name, select a different font (if desired).

4 Click OK.

An Empty Movie
(contains an “Empty 
Video” holder only)
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Renaming a Button Title
You can rename a button title on a menu with a more descriptive name 
(for example, “The Bahama Islands”).

Note  Renaming a button title renames its corresponding movie 
title in the Workshop and, renaming a movie title renames its 
corresponding button title in the menu. See Renaming a Movie 
Title on page 52.

To rename a button title:

1 Double-click the menu in the Workshop. The menu appears in the 
Screening Room.

2 Click the button title.

3 Type a new name, select a different font (if desired).

4 Click OK. 

Changing the Menu Background
You can replace the menu background by importing a video clip or still 
image on your hard disk. (Choosing a different menu theme also changes 
the menu background. See Choosing a Menu Theme on page 76.)

To change the menu background:

1 Double-click the menu in the Workshop. The menu appears in the 
Screening Room.

2 Do one of the following:

■ Drag a still image or a video clip from Windows Explorer to the 

menu in the Screening Room.

■ Click the Multimedia Files  button and drag a still image or 

video clip file from the dialog box to the menu in the Screening 

Room.
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Changing the Thumbnail Image of a Button
You can change the thumbnail image that appears inside a button on the 
menu. The image is typically the first image of your movie.

To change the thumbnail image:

■ Move the desired still image or video clip to the first image of your 
movie.

Note  If you want to use a specific frame of a video clip as the 
thumbnail image of a button, you can extract the frame and then 
move that extracted frame to the first image of your movie. See 
Extracting a Frame From a Video Clip on page 56.

Removing a Submenu
You can remove a submenu by removing it from the Workshop. You 
cannot remove the main menu from a project.

To remove a submenu, do one of the following:

■ Drag the submenu from the Workshop to Trash .

■ Right-click the submenu in the Workshop and select Delete.

Note  If a submenu contains movies and you drag the submenu to 
Trash, you can retrieve the movies by clicking Trash and dragging 
the movies back to the Workshop.
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Removing a Menu Button
You can remove a menu button by removing the movie (that the button 
represents) from the menu in the Workshop. 

To remove a movie from a menu, do one of the following:

■ Drag the movie handle from the Workshop to a different menu or to 
Trash.

■ Right-click the movie handle in the Workshop and select Delete.

Adding Sound to a Menu
You can add one audio file at a time to a menu, for example, to provide 
background music for the menu. If you add audio to a motion menu that 
already contains sound, DVD Builder asks you to confirm that you want to 
replace the original audio with the new audio.

Note  It is generally a good rule to add audio that is shorter than 
(or equal in length to) a motion menu. If the sound is longer than 
the motion menu, it will cut off and start over from the beginning 
when the motion menu loops.

There are several ways to add an audio file to a menu:

■ Click the Multimedia Files  button and drag an audio file from 
the Import Multimedia dialog to a menu in the Workshop. (To sort 

your multimedia files by audio file, click the Audio Files  button.)

■ Right-click the menu in the Workshop and select Attach Audio. Select 
the audio file in the Browse dialog.

■ Drag an audio file from Windows Explorer directly to the menu in the 
Workshop.
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Note  You can also add audio tracks to a menu by dragging them 
directly from an audio CD (a process called “ripping”). For more 
information, see Ripping Audio to a Movie, Video Clip, Still Image, 
or Menu on page 58.

Removing Sound from a Menu

To remove an audio file from a menu:

■ Right-click the menu in the Workshop and select Remove Audio.
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Changing Menu Themes
In this chapter

What are Menu Themes? 76

Opening the Menu Theme Library 76

Choosing a Menu Theme 76
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What are Menu Themes?
The Menu Theme Library allows you to apply different menu themes to 
your menus.

A variety of menu themes is provided with DVD Builder. Each menu 
theme consists of a moving menu background, button shapes, music, and a 
font typeface for your menu and button titles.

Opening the Menu Theme Library

To open the Menu Theme Library:

■ Click Menu Theme Library  in the DVD Builder Library Drawer. 
The Menu Theme Library opens.

Choosing a Menu Theme

To choose a menu theme:

■ Drag the desired menu theme from the Menu Themes Library to the 
menu you want to replace in either the Workshop or Screening Room.

■ If a menu is currently displayed in the Screening Room, double-click 
the desired menu theme from the Menu Themes Library to replace the 
menu.

Menu Theme Library
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Adding Transitions
In this chapter

What are Transitions? 78

Opening the Transition Library 78

Adding a Transition 79

Setting the Duration of a Transition 80

Removing a Transition 80
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What are Transitions?
Transitions are the visual changes from one clip to another. Typically, you 
add a transition between two adjacent video clips or still images; however, 
you can add a transition wherever there is a transition holder.

Opening the Transition Library
DVD Builder provides a variety of transitions. Mouse over a transition in 
the Transition Library to view a thumbnail sample of the transition. 

To open the Transition Library:

■ Click Transition Library  in the DVD Builder Library Drawer. The 
Transition Library opens.

Transition Holder 
(Empty)

Transition Holder (Turns Yellow 
When Transition is Added)

Transition Library
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Adding a Transition
You can add a transition to individual video clips or still images, or you can 
add a transition to an entire movie.

To add a transition to individual video clips or still images:

■ Drag the desired transition from the Transition Library to the 
transition holder of the video clip or still image. The transition holder 
turns yellow to indicate a transition has been applied.

To add a transition to the entire movie:

■ Drag the desired transition from the Transition Library to the movie 
handle. All transition holders in the movie turn yellow to indicate a 
transition has been applied.

Transition Holder 
(Empty)

Transition Holder 
(With Transition)

All Transition Holders Turn Yellow

Movie Handle
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Note  You can apply random transitions to all video clips and still 
images in the movie by right-clicking the movie handle and 
selecting Apply Random Transitions to All Clips in Movie.

Setting the Duration of a Transition

To adjust the duration of a transition:

1 Right-click the transition holder of a video clip or still image in the 
Workshop and select Duration.

2 Select a pre-defined transition duration (you can select 1, 3, or 5 
seconds).

Removing a Transition

There are two ways to remove a transition:

■ Right-click the transition holder of a video clip or still image and select 
Remove. The transition is removed.

■ To remove all transitions from the movie, right-click the movie handle 
and select Remove Transition From All Clips In Movie. All transitions 
are removed from the movie.
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Creating a Slideshow
In this chapter

Creating Slideshows in DVD Builder 82
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Creating Slideshows in DVD Builder
You can easily create a slideshow, which is simply a movie that contains 
only still images. When viewed, each still image is displayed for the amount 
of time you set, in the order you arrange them.

Here is a reference to the sections that will help you put your slideshow 
together:

■ Select Your Still Images: See Importing Multimedia Files on page 41 and 
Importing From Other Sources (Digital Still Camera, Scanner, and More) 
on page 40.

■ Setting the Duration of Each Still Image: See Setting the Duration of a 
Still Image on page 55.

■ Adding Transitions Between Still Images: See Adding a Transition on 
page 79.

■ Adding Music to Your Slideshow: See Adding Sound to a Movie, Video 
Clip, or Still Image on page 56.

■ Deleting an Image from a Slideshow: See Selecting and Moving Parts of 
Movie on page 53.

■ Changing the Order of Images in Your Slideshow: See Selecting and 
Moving Parts of Movie on page 53.

■ Add Slideshow as Menu Button: See Adding Movies to a Menu on 
page 68.

■ Sync the Display Time of Your Images to Audio: See Stretching Image 
Duration to Fit Sound Length on page 58.

Note  To reduce the processing time and the amount of hard disk 
space required to burn your slideshow to disc, create your 
slideshow without any motion menus or transitions, and burn 
your project to either a VCD or SVCD disc. This is especially 
useful when you have lots of photos that you want to archive to 
disc.
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Using the Remote Control
In this chapter

Previewing your Project Before Burning Your Disc 84

Using the Remote Control 84
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Previewing your Project Before Burning Your 
Disc
The remote control allows you to preview your project as it would appear 
when viewed on your TV. This is a low quality preview designed to give 
you a quick way of viewing your project. 

Note  It is always a good idea to preview your project before 
actually burning it to disc.

To preview your project with the remote control:

■ Click the Remote Control  icon. A preview window opens, with 
the remote control displayed to the right side of the screen.

Using the Remote Control
The remote control works like a standard DVD remote control used to 
control a set-top DVD player.

Play Buttons

Special Menu Buttons

Menu Navigation Buttons

Close Preview
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Using the Special Menu Buttons
The Special Menu buttons let you navigate through menus more easily:

■ Main Menu button: Displays the topmost menu in your project, from 
which all other submenus are derived.

■ Intro button: Displays the Intro movie.

■ Return to Last Menu button: Displays the menu that the current menu 
is derived from.

Using the Play Buttons
The Play Buttons control navigation through movies.

Main Menu
Intro Movie

Return to Last 
Menu

Next 
Chapter

Previous 
Chapter

Stop PausePlay

Rewind Fast-
Forward
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Using the Menu Navigation Buttons
The Menu Navigation buttons let you cycle through and select buttons 
within a menu.

Note  This feature of the remote control applies to DVD only.

Using Other Features with Remote Control Preview
Here are some other features you can use while using the remote control:

■ Click the Close Preview button (the X in the right-corner of the remote 
control) to exit the preview.

■ In the preview, click on a menu button to jump to that menu.

■ To drag the remote control around the screen, click and drag on the 
top of the remote control, just above the Special Menu buttons.

Activate 
Button

Select Button 
to Left

Select Button 
Above

Select Button 
to Right

Select Button 
Below
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Burning Your Disc
In this chapter

Burning Your Disc 88

Saving a Project as an Image File to Hard Disk 90

Burning an Image File to Disc 92



Easy CD & DVD Creator 6 Expanded User’s Guide: DVD Builder
Chapter 10: Burning Your Disc 88

ECDC_6_0_UserGuide_DB.book  Page 88  Monday, December 16, 2002  1:52 PM
Burning Your Disc
When you have finished organizing and editing your project, you are ready 
to burn (record) it to a DVD-Recordable (DVD format) or CD-Recordable 
(VCD, SVCD, or miniDVD format) disc.

Note  If you plan to use a disc that is not rewritable, make sure 
you have finished and previewed your project before burning it to 
disc. Once you start burning your disc, it cannot be overwritten. If 
you change your project, you have to burn it to a new, blank disc.

To burn your project to disc:

1 Insert a disc into your recorder.

2 Click the Burn button. The Burn Project dialog box appears.

3 From the Destinations drop-down list, select your recorder.

If you have inserted a rewritable disc that already has information on 
it, click Erase to wipe out its contents before you begin recording the 
project to disc.

4 From the Write Speed drop-down list, select the appropriate write 
speed for the recorder you chose in the Destinations drop-down list.

Note  Some media cannot be burned to using the high write 
speeds of your recorder, and will be burned at a lower speed.
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5 In the Number of Copies field, enter the number of discs you want to 
burn. If you are burning more than one project at a time, you will be 
prompted to insert a new disc before each burn.

6 If your project contains still images, you can include the original 
graphic files on your disc in a folder called IMAGES. To do this, check 
the box marked Save Still Images to Disc.

If you do not want your still images to be available as graphic files on 
your final disc, leave the box unchecked.

Note  If you plan to distribute your final disc and you do not want 
others to have access to your original graphic files, make sure to 
leave this box unchecked.

7 Under Output disc type, select the type of disc you want to burn:

■ VCD (Video CD): CD-Recordable disc in the VCD format, which 

can be played in most newer-model set-top DVD players. A VCD 

holds approximately 40-50 minutes of video and results in lower 

video quality than the SVCD, DVD, and miniDVD formats.

■ SVCD (Super Video CD): CD-Recordable disc in the SVCD format, 

which can be played in most newer-model set-top DVD players. 

An SVCD holds approximately 15-20 minutes of video and results 

in higher video quality than the VCD format, but is not as good as 

the video quality in the DVD or miniDVD formats.

Note  While VCD and SVCD discs can be played by most newer 
set-top DVD players, many older set-top DVD players will be 
unable to play these types of discs.

■ DVD (or miniDVD): DVD-Recordable disc, which can be played 

on almost any set-top DVD player. A DVD holds approximately 

two hours of video and has the highest video quality.

You can also use this option to burn a CD-Recordable disc in the 
miniDVD format, which can be played only on a computer using 
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third-party DVD playback software. A miniDVD holds 
approximately 15-20 minutes of video and also has the highest 
video quality (equivalent to DVD).

Note  We recommend using a DVD-Recordable disc to get the 
highest video quality and the largest capacity.

8 Click OK. An encoding progress bar for each movie displays as each 
movie is encoding. This may take a while.

When encoding is finished, a dialog box appears and displays the 
progress of the burn.

Saving a Project as an Image File to Hard Disk
Instead of burning your project to disc, you can save the entire contents of 
your project into a single file known as an image file. This file will contain 
all the information necessary to burn your project to a disc directly from 
your hard disk.

You might want to save your project as an image file for these reasons:

■ To make multiple copies of your project

■ To allow someone else to burn your project to disc while preventing 
them from changing your project

■ You do not have a disc on hand, but want to burn to disc later



Easy CD & DVD Creator 6 Expanded User’s Guide: DVD Builder
Chapter 10: Burning Your Disc 91

ECDC_6_0_UserGuide_DB.book  Page 91  Monday, December 16, 2002  1:52 PM
Note  Because video encoding is part of the image file, you still 
need to select the video quality type that you want to burn the final 
disc with (VCD, SVCD, DVD, or miniDVD).

To save your project as an image file:

1 Click the Burn  button. The Burn Project dialog box appears.

2 Select the type of disc you want this image file to be able to create:

■ VCD (Video CD): CD-Recordable disc in the VCD format.

■ SVCD (Super Video CD): CD-Recordable disc in the SVCD format.

■ DVD (miniDVD): DVD-Recordable disc. You can also use this 

option to burn a CD-Recordable disc in the miniDVD format.

3 Click Advanced to display the Advanced portion of the Burn Project 
dialog box. 

4 Check Save Project as Image File on Hard Disk, then click Browse.

A dialog box appears, where you can type a name for the image file and 
navigate to the location on your hard drive where you want to save it.



Easy CD & DVD Creator 6 Expanded User’s Guide: DVD Builder
Chapter 10: Burning Your Disc 92

ECDC_6_0_UserGuide_DB.book  Page 92  Monday, December 16, 2002  1:52 PM
5 In the Burn Project dialog box, click OK. An encoding progress bar for 
each movie displays. This may take a while.

When encoding is finished, a dialog box appears and displays the 
progress of the disc image being saved.

Burning an Image File to Disc
You can burn a previously-created image file of a project to a disc.

To burn an image file to a disc:

1 From the File menu, select Burn Disc from Image File.

A dialog box appears, where you must locate the image file you want to 
burn to disc. (Click OK when you are finished.)

The Burn Project dialog box appears.

2 Insert a disc into your recorder.

Note  Make sure to insert media that matches the type of video 
encoding that was selected before the image file was created (VCD, 
SVCD, DVD, or miniDVD). For example, if the VCD option was 
selected when the image file was saved, you can only burn to a CD-
Recordable or CD-ReWritable disc.

3 From the Destinations drop-down list, select your recorder.
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If you have inserted a rewritable disc that already has information on 
it, click Erase to wipe out its contents before you begin recording the 
project to disc.

4 From the Write Speed drop-down list, select the appropriate write 
speed for the recorder you chose in the Destinations drop-down list.

5 In the Number of Copies field, enter the number of discs you want to 
burn. If you are burning more than one project at a time, you will be 
prompted to insert a new disc before each burn.

6 In the Burn Project dialog box, click OK. 

A dialog box appears and displays the progress of the burn. This may 
take a while.
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Testing Your Disc
In this chapter

Testing a Disc You Have Burned 96

Set-top DVD Players Supported by DVD Builder 96
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Testing a Disc You Have Burned
After you have burned your disc, it is a good idea to test it in a set-top DVD 
player to see if it plays correctly.

Note  Some older set-top DVD players may have problems 
playing your disc, and some newer model set-top DVD players 
may have problems playing a CD-R, but will play a CD-RW.

Note  If you do not have a set-top DVD player, you can use third-
party DVD playback software on your computer to test your DVD. 

To test your disc:

1 Insert your disc into a set-top DVD player.

2 Using the controls on your set-top DVD player, go to the main menu 
of your new disc.

3 To make sure your disc works correctly, it is a good idea to test all 
menus and navigation buttons.

Set-top DVD Players Supported by DVD 
Builder
DVD discs burned with DVD Builder can be played in most set-top DVD 

players. VCD and SVCD discs burned with DVD Builder can be played in 

most newer model set-top DVD players.

Note  If you have successfully tested the disc as described in 
Testing a Disc You Have Burned on page 96, then you should be 
able to play it on your set-top DVD player.

For supported media types and formats, see your set-top DVD player 
documentation.
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DVD Builder Reference
In this chapter

DVD Builder Menu Reference 98

Keyboard Shortcuts 101

Right-Click Menus 102
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DVD Builder Menu Reference
The following menus are available in DVD Builder:

■ File Menu

■ Import Menu

■ Edit Menu

■ Help Menu

File Menu
The following table lists the commands under the File menu.

Command Description

New Project Starts a new DVD Builder project.

Open Project Opens a previously saved DVD Builder project.

Save Project Saves your DVD Builder project.

Save Project 
As

Saves your DVD Builder project under a different 
name.

Delete 
Project

Deletes DVD Builder projects.

Real Time 
Recording

Imports digital video directly from a DV source to a 
disc.

Load Project 
From DVD 
VR Disc

Imports the contents of a DVD VR disc into DVD 
Builder.

Burn Disc 
From Image 
File

Burns a previously saved image file to disc.

Preferences Displays the Preferences dialog box. The dialog box 
lets you set video and project settings.

Exit Quits DVD Builder.
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Import Menu
The following table lists the commands under the Import menu.

Edit Menu
The following table lists the commands under the Edit menu.

Command Description

Video 
Capture

Displays the controls for capturing video in the 
Screening Room.

Still Image 
Capture

Displays the controls for capturing still images.

Import Files Opens the Import Files dialog box to import 
multimedia files already saved to your hard disk.

Command Description

Undo Restores a video clip to its original state before it was 
trimmed or split.

Trim Clip Left Removes everything to the left of the current location 
of the selected video clip; the discarded portion is 
added to Trash.

Trim Clip 
Right

Removes everything to the right of the current 
location of the selected video clip; the discarded 
portion is added to Trash.

Split Clip Splits the selected video clip into two clips at the 
current location.
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Help Menu
The following table lists the commands under the Help menu.

Command Description

DVD Builder 
Help

Opens the DVD Builder Online Help.

About DVD 
Builder

Opens the About dialog box for DVD Builder, which 
displays the application's version number and 
copyright notice.

Roxio Web 
Update

Allows you to connect to Roxio’s website to 
automatically check for updates to DVD Builder.
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Keyboard Shortcuts
You can use your keyboard instead of your mouse to access menu 
commands. An underlined letter in a menu item or command indicates 
the keyboard shortcut you would type to choose that option.

To Press

Start a new project ALT-F-N

Open a previously saved project ALT-F-O

Save your project ALT-F-S

Save your project under a different name ALT-F-A

Delete a project ALT-F-D

Import digital video directly from a DV source to a disc. ALT-F-R

Import the contents of a DVD VR disc into DVD 
Builder.

ALT-F-L

Burn a previously saved image file to disc ALT-F-B

Display the Preferences dialog box. ALT-F-P

Quit DVD Builder ALT-F-E

Display the controls for capturing video in the Screening 
Room

ALT-I-D

Display the controls for capturing still images. ALT-I-S

Open the Import Files dialog box ALT-I-F

Restore a video clip to its original state before it was 
trimmed or split

ALT-E-U

Remove everything to the left of the current location of 
the selected video clip

ALT-E-L

Remove everything to the right of the current location of 
the selected video clip

ALT-E-R

Split the selected video clip into two clips at the current 
location

ALT-E-S

Open the DVD Builder Online Help ALT-H-H

Open the About dialog box for DVD Builder ALT-H-A

Connect to Roxio’s website to automatically check for 
updates to DVD Builder

ALT-H-R
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Right-Click Menus
Right-clicking the following items will display a pop-up menu of 
commands that you can choose from:

■ Menu

■ Submenu

■ Movie Title

■ Video Clip

■ Still Image

■ Transition Holder

■ Audio Attached Icon

■ De-noiser Icon

Right-click a Menu
The following table lists the pop-up menu of commands that are available 
when you right-click a menu in the Workshop.

Command Description

Attach To 
Menu

Attaches the menu to a different menu.

Paste Works similar to Paste from the Clipboard; however, 
you can only paste a video clip or still image into a 
menu.

Delete Removes the menu from the Workshop and adds it to 
Trash.

Remove 
Audio

Removes any audio file associated with the menu.
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Right-click a Submenu
The following table lists the pop-up menu of commands that are available 
when you right-click a submenu in the Workshop.

Right-click a Movie Title
The following table lists the pop-up menu of commands that are available 
when you right-click a movie title in the Workshop.

Command Description

Attach to 
Menu

Attaches the menu to a different menu.

Paste Works similar to Paste from the Clipboard; however, 
you can only paste a video clip or still image into a 
menu.

Delete Removes the submenu from the Workshop and adds 
it to Trash.

Remove 
Audio

Removes any audio file associated with the menu.

Command Description

Attach to Menu Attaches the movie to a different menu.

Paste Works similar to Paste from the Clipboard; 
however, you can only paste a video clip or still 
image into a movie.

Rename Renames the movie title.

Delete Removes the movie from the Workshop and adds it 
to Trash.

Preview Displays the movie in the Screening Room.

Attach Audio Attaches an audio file to the movie.

Stretch Still 
Image Duration 
to Fit Sound 
Length

If an audio file attached to a movie is longer than 
the movie, this option automatically stretches the 
display times (durations) of the still images in the 
movie to equal the length of the audio file. This 
option applies only to movies that contain still 
images.
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Right-click a Video Clip
The following table lists the pop-up menu of commands that are available 
when you right-click a video clip in the Workshop.

Still Images 
Duration

Sets the amount of time that all still images in the 
movie are displayed.

Apply De-noiser 
to All Clips in 
Movie

Applies the De-noiser filter to all video clips in the 
movie.

Apply Random 
Transitions to All 
Clips in Movie

Applies random transitions to all video clips and 
still images in the movie.

Remove 
Transition From 
All Clips in 
Movie

Removes all transitions from all video clips and still 
images in a movie.

Remove De-
noiser From All 
Clips in Movie

Removes the De-noiser filter from all video clips in 
a movie.

Command Description

Cut Removes the video clip from the Workshop and 
allows you to paste it to a menu or movie.

Copy Copies the video clip and allows you to paste it to a 
menu or movie.

Delete Removes the video clip from the Workshop and adds 
it to Trash.

Extract Frame Extracts a single frame of the video clip to a .bmp 
graphic file. The extracted .bmp is added to the movie.

Undo/Trim 
Split

Reverts to the original video clip before it was 
trimmed or split.

Attach Audio Attaches an audio file to the movie.

Remove 
Audio

Removes any audio file associated with the video clip.

Command Description
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Right-click a Still Image
The following table lists the pop-up menu of commands that are available 
when you right-click a still image in the Workshop.

Right-click a Transition Holder
The following table lists the pop-up menu of commands that are available 
when you right-click a transition holder that has a transition.

Remove 
Transition

Removes any transition associated with the video clip.

Apply 
De-noiser

Applies the De-noiser filter to the video clip.

Command Description

Cut Removes the still image from the Workshop and 
allows you to paste it to a menu or movie.

Copy Copies the still image and allows you to paste it to a 
menu or movie.

Delete Removes the still image from the Workshop and adds 
it to Trash.

Rotate Rotates the still image clockwise or counter-clockwise 
90 degrees.

Duration Sets the amount of time the still image is displayed in 
the movie.

Attach Audio Attaches an audio file to the movie.

Remove 
Audio

Removes any audio file associated with the video clip.

Remove 
Transition

Removes any transition associated with the still image.

Command Description

Remove Removes the transition from the transition holder.

Duration Sets the amount of time the transition is displayed.

Command Description



Easy CD & DVD Creator 6 Expanded User’s Guide: DVD Builder
Chapter 12: DVD Builder Reference 106

ECDC_6_0_UserGuide_DB.book  Page 106  Monday, December 16, 2002  1:52 PM
Right-click an Audio Attached Icon
The following table lists the pop-up menu of commands that are available 
when you right-click an Audio Attached icon in a video clip or still image.

Right-click a De-noiser Icon
The following table lists the pop-up menu of commands that are available 
when you right-click a De-noiser icon in a video clip.

Command Description

Remove Removes the audio file from the video clip or still 
image and adds it to Trash.

Command Description

Remove Removes the De-noiser filter from the video clip.
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activate menu button 86
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audio files from CD 58
movies to menu 68
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video clips 4, 70

.aif file 43
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import button 37
importing 16, 37
tape source 34

application menus 5
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audio files

adding to menu 72
adding to movie, image, clip 56
importing 4
naming conventions 61
removing from menu 73

Audio Video Interlaced (AVI) 42
.avi file 42

B
background image 6, 24, 64, 67, 70, 76
background music 6
Beta analog tape source 37
bitmaps 43
.bmp file 43, 56
boundary color 16, 28, 50, 68
burn 88
burn button 3, 7, 21, 30, 88
burning

disc 2, 3, 7, 21, 30, 88
image file to disc 92
more than one copy 89, 93
previewing before 84
testing after burning 96

buttons 26
add menu 8
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importing 3, 21
menu 6, 52, 64, 67, 68, 76
menu navigation 86
play 85
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remote control 84
special menu 85
thumbnail image 71
titles 5, 6, 64, 70, 76

C
camcorder 34
camera mode 34
capture folder 15
captured video 13
capturing

analog capture card 37
analog video 37
digital video 34
settings 36
video 2, 5
webcam 37

CD-R disc 2, 88, 96
CD-RW disc 96
changing thumbnail image 71
close preview 84
closing 9
closing DVD Builder 3
color, boundary 16, 28, 50, 68
commentary

recording 59
commentary, recording 59
computer, playback software 90
controls

playback 54, 56
remote control 84
slider 56

copyright information ii
counter 54
creating

new movie 50, 68, 69
slideshows 82

D
.dat file 42
deleting

movies 52, 55
still images 29, 53
video clips 29, 53

de-noiser 61
destinations 88, 92
dialog box

select frame 56
select input device 40

digital still camera 40
importing from 4

digital video
capture settings 36
capturing 34
import button 4, 22, 35
importing 16, 34

disc
formats 9

disc size status 3
discs

burning image file to disc 92
burning project to disc 88
previewing before burning 84
testing after burning 96

displaying files 41
.divx file 43
drawer, library 7
duration

still image 55
stretching for images 58
transition 80

DV camcorder 4, 34
DVD 89, 91
DVD player 51
DVD VR 4, 43, 44
DVD-Recordable



Easy CD & DVD Creator 6 Expanded User’s Guide: DVD Builder
Index 109

ECDC_6_0_UserGuide_DB.book  Page 109  Monday, December 16, 2002  1:52 PM
disc 2, 88, 89, 91

E
edit

still images 2
transitions 80
video clips 2

edit menu 99
energy saving features 15
extra footage 17
extracting frame 56

F
fast-forward 85
FBI warning 51
file menu 98
files

displaying 41
import button 41, 50, 69, 70
multimedia 4

folder for captured video 13
font typeface 76
formats

disc 9

H
handle, movie 50, 68
hard disk

defragment 15
image file 7
importing 34
multimedia files 41
space 15

help 3

help menu 100
Hi8 analog tape source 37
holder, transition 50

I
image

stretching duration 58
image files

advantages 90
burning to disc 92
hard disk 7
saving to hard disk 90

import
analog video 16, 34, 37
audio files 4
buttons 3, 4, 21, 37
digital still camera 4
digital video 4, 34
files 2, 41, 42, 50, 69, 70
hard disk 34
multimedia files 41, 42
other device 34
other sources 40
scanner 4
still images 4, 40
video clips 4, 16, 70

import menu 99
intro movie 6, 17, 51, 85

J
JPEG files 43
.jpg file 43



Easy CD & DVD Creator 6 Expanded User’s Guide: DVD Builder
Index 110

ECDC_6_0_UserGuide_DB.book  Page 110  Monday, December 16, 2002  1:52 PM
K
keyboard shortcuts 101

L
library

drawer 3, 7
menu themes 7, 25
transitions 7, 21, 27, 78

load project 12

M
.m2p file 42
main menu 51, 85
maximize 9
menu

background image 24
menu navigation 30, 84
menu theme library 21
menus 6, 16, 26

add 3, 8, 21
adding sound 72
application 5
background image 5, 6, 64, 67, 70, 76
button 5
buttons 5, 6, 52, 64, 67, 68, 72, 76
customizing 2
defined 64
main 51
motion 82
movies 68
music 76
organizing files 2
organizing movies 65
previewing 5, 66, 67

project 3
removing 71
removing sound 73
submenus 6, 8, 16, 66
themes 7, 25, 64, 76
title 5, 6, 26, 64, 66, 67, 69

microphone 59, 60
miniDVD 88, 89, 91
minimize 9
motion menu 82
.mov file 43
movie

adding sound 56
creating new 50, 68, 69
defined 50
deleting 52, 55
handle 50, 52, 68
in the workshop 6
intro 51
menu buttons 64
moving 52
organizing into menus 65
previewing 5, 53
removing from menu 52
titles 50, 52

moving
in menus 86
still images 53
video clips 29, 53

.mp2 file 43

.mp3 file 43, 58

.mpa file 43

.mpeg file 42

.mpg file 42
multimedia files 4, 41, 42
multiple copies, burning 89, 93
music, background 6, 76
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N
narrating your project 59
narration 59
next chapter 85
NTSC 13

O
online help 3
open project 11
organizing files 2
other device

importing 34
other sources

import button 40
output disc type 89

P
PAL 13
pause 85
personalizing 2
play 85
playback controls 54, 56
preferences, video 13
previewing

files 41
menus 5, 66, 67
movie 5, 53
project 8
screening room 3, 5, 21
still images 5, 40, 41, 53
stop preview 86
video clips 5, 23, 36, 40, 41, 53
with remote control 29, 84, 86

previous chapter 85

project
load 12
menu 3
opening 11
saving 11
size 3, 9

Q
QuickTime movie 43
quitting DVD Builder 3, 9

R
real time recording 4, 44
recording commentary 59
recording device 59

selecting 59
remote control 3, 8, 21, 84

buttons 84
closing 86
dragging 86
preview 29, 84, 86

removing
menu button 72
menus 71
sound from menu 73
still images 53
transitions 80
video clips 53

renaming
button title 70
menu title 69
movie title 52

resizing work area 10
restoring a video clip 55
return to last menu 85
rewind 85
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ripping audio from CD 58
rotating a still image 55

S
saving

image file to hard disk 90
projects 11

scanner 40
importing from 4

screen saver 15
screening room 3, 5, 21
select frame dialog box 56
select input device dialog box 40
set-top DVD players 96

CD-R discs 96
CD-RW discs 96
supported 96

shortcuts, keyboard 101
slider control 56
slideshow 82
sound

adding to menu 72
adding to movie, image, clip 56
removing from menu 73

special menu 30, 84, 85
splitting video clips 54
start capture 23, 36, 39, 46
still images

adding sound 56
deleting 29, 53
duration 55
editing 2
importing 4, 40
improving quality 16
inside a movie 50
moving 53
previewing 5, 40, 53
removing 53

rotating 55
trimming 2

stop 85
stop capture 23, 36, 39, 46
stop preview 30, 84, 86
streaming audio 39
streaming video 22, 35, 39, 46
stretching image duration 58
submenus 6, 16, 28, 66
SVCD 2, 9, 82, 88, 89, 91
.svd file 42

T
tape source, analog 34
taskbar 9
testing your disc 96
themes, menu 7, 64, 76
third-party

playback software 90, 96
recording device 59

thumbnail 23, 36, 71
time counter 54
tips, using DVD Builder 15
titles

button 5, 6, 64
menu 5, 6, 64, 66, 67

trademarks ii
transition 7, 17, 27, 78, 82

editing 80
holder 27, 50, 79
library 21, 27, 78

trash 3, 8, 54
trimming

still images 2
video clips 2, 54

TWAIN 4, 40
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U
undo trim/split 55

V
VCD 2, 9, 42, 82, 88, 89, 91, 96
VCR mode 21, 34
VHS analog tape source 37
video clips

adding sound 56
capturing 5
deleting 29, 53
editing 2
extracting frame 56
importing 4, 70
improving quality 16
inside a movie 50
moving 29, 53
previewing 5, 23, 36, 40, 53
removing 53
restoring 55
splitting 54
trimming 2, 54

video preferences 13
video quality 13, 89, 91
.vob file 42

W
.wav file 43, 58
webcam 37, 59
WIA 4, 40
Windows Image Acquisition 4, 40
Windows Media Audio 43
.wma file 43
.wmv file 43

work area 3
moving 10
resizing 10

workshop 3, 6, 21
movies 6

write speed 88, 93

Z
zoom controls 3, 7, 11, 21
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